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Reading &
Proofreading

Microsoft Word has a number of tools to help you with your

reading and proofreading. Microsoft Edge also has tools to

support you while reading online sources. These will be explored

over the next few pages.




Read Aloud

Using text to speech in Microsoft Word to have text read out loud.

Open up Microsoft Word. To get started, click on the ‘View’ tab, highlighted below.
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From the ribbon, click on the ‘Learning Tools’ icon. | ’[ |
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Learning

The ‘Learning Tools’ toolbar will now be displayed.
Tools
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Enabling the Learning Tools toolbar will reduce the column width of your
document, to aid reading. When you close Learning Tools your document will
revert to its original column width.

You can use the ‘Read Aloud’ feature to listen back to your document.

Select ‘Read Aloud’ or press CTRL + ALT + Space.

The Read Aloud toolbar will load on the right-hand side of the screen.
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Select the play button or press CTRL + Space to start playing back the text.




Read Aloud cont.

The text will now be played back, and the currently spoken word will be
highlighted in Word.
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Escafeld, as the historic town of Sheffield was called at the time of Domesday Book
(1086), was an Anglo-Saxon village. It became the site of a castle and a parish church
built by the Norman lord William de Lovetot early in the 12th century. From
medieval times the local iron or was smelted with char coal obtained from the
nearby abundant woodlands, and smiths and cutlers used the excellent local

sandstone for grindstones.

During the 15th century the streams that converge on Sheffield began to be used for
power for grinding and forging operations. A cutlery industry thus grew, and

Sheffield emerged in the 17th century as the main provincial cutlery town and a

powarful rivalta landan By 1700 landan too had hean dafeated and thora oftar

As the text is played back, the play button becomes a pause button.
You can now use this button to pause playback of your text.

The ‘back’ button will rewind the readback to the start of the
paragraph. If you press it twice quickly it will rewind to the previous
paragraph. You can also press CTRL + left arrow to go back.

The ‘forward’ button will fast-forward the text by one paragraph
when pressed. You can also press CTRL + right arrow.

Next we will take a look at changing the speech settings.




Speech Settings

You are also able to change the voice and speed of voice.

Press the settings button. r:'

The following menu will appear:

You are now able to change the reading

<[] [> []>’ 'f'ﬁ- X speed and voice.

‘ You can also press Alt + left arrow to slow
Reading speed down the voice, or Alt + right arrow to speed

——y ] w

Voice Selection

Tip: You can use the Read Aloud toolbar
without having to open Immersive Reader.
Click on the ‘Review’ tab on the Word ribbon
and select ‘Read Aloud’, highlighted below -
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You can also use the keyboard shortcut CTRL + ALT + Space to load Read Aloud.

In the next section we will look at using reading tools with the Microsoft Edge web
browser.




Microsoft Edge

Microsoft Edge is the default web browser for Windows 10.
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Sheffield, town, city, and metropolitan borough, metropolitan county of South
Yorkshire, north-central England. Sheffield lies about 160 miles (260 km)
northwest of London. The city and metropolitan borough lie within the historic
county of Yorkshire, except for the area around Beighton and Mosborough,
which belongs to the historic county of Derbyshire. Sheffield is situated at the

foot of the Pennine highlands at a point where four streams—the Sheaf, Porter,

Rivelin, and Loxley—running in deep valleys converge to form the River Don.

To access text-to-speech in Microsoft Edge you need to firstly load the page that
you wish to be read back. The ‘Reading View’ icon should now be available in the
address bar:
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Select the Reading View icon or press CTRL + Shift + R. The page will now reload
in Reading View -
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South Yorkshire, north-central Eng-
land. Sheffield lies about 160 miles
(260 km) northwest of London. The
city and metropolitan borough lie

within the historic county of York-

The web page has now reloaded with only the main article visible. The text is
larger, and the column is thinner than the original web page.




Reading View tools

Whilst in Reading View, we can navigate the document and access additional tools
from the Reading View toolbar.

To navigate, you can use the ‘back’ and ‘forward’ buttons to navigate
through the document or press the left and right arrows on your
keyboard.

To display the Reading View toolbar hover and click your mouse near the top of the
page, or press CTRL + SHIFT + Y. The toolbar will now load.
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Here’s a closer look at the toolbar -
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You can select ‘Read Aloud’, or press CTRL + SHIFT + G to load the reading toolbar -

R

When you open Read Aloud, the document will automatically start reading from the
beginning of the current page - CEEECTIEY —
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The text not being read out
will automatically be dimmed. BT, e i e
If you wish to start reading
back from elsewhere on the
page, select the text where
you want readback to begin
and then click Read Aloud.




Reading View tools cont.

When the document is being read back, the play button becomes
the ‘pause’ button. It looks like this -
Select this to pause the readback or press CTRL + Space.

The appearance of the reading toolbar in Edge is very similar to the reading toolbar
in Microsoft Word.

The only major difference is the ‘Settings’ button, which in Edge
looks like this - Fl:‘]

When you select the settings button, the following menu will load -

In this menu you can adjust the speed and

Speed voice to your preferences.

Voice The next section will focus on reading back
Microsoft Susan - English (Uniti text from a PDF displayed in Microsoft Edge.

Learn how to add more voices




Reading Back a PDF

You can also use the read aloud tool in Edge when viewing a PDF.

The Reading View or Learning Tools toolbar are not available when viewing a PDF.
However a ‘Read Aloud’ button is available on the toolbar.
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Select the button as highlighted or press CTRL + SHIFT + G to load the Read
Aloud toolbar.

The toolbar will load and readback will automatically begin at the start of the
document.
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Escafeld, as the historic town of Sheffield was called at the time of Domesday Book (1086), was an
Anglo-Saxon village. It became the site of a castle and a parish church built by the Norman lord
William de Lovetot early in the 12th *. From medieval times the local iron ore was smelted with char
coal obtained from the nearby abundant woodlands, and smiths and cutlers used the excellent local

sandstone for grindstones.

During the 15th century the streams that converge on Sheffield beganto be used for power for
grinding and forging operations. A cutlery industry thus grew, and Sheffield emergedin the 17th
century as the main provincial cutlery town and a powerful rival to London. By 1700 London, too,

had been defeated, and there after Sheffield enjoyed a virtual monopoly of the English cutlery trade.

(from Encyclopaedia Britannica)

The current line is highlighted as the text is read back, and the rest of the text is
dimmed.

To start playing from a specific place in the document, select text in the desired
area and select play. This will also open the right-click menu, but you can safely
ignore this.




Layout, Colour
and Focus

Microsoft Word and Microsoft Edge have a range of options that
enable the user to customise the coloumn width, text spacing
and background colours, along with implementing a line focus to
aid tracking. These options will be explored over the following

section.




Changing the Column Width

Reducing the column width can make reading documents easier, as your eyes have
less to scan.

We can change the width of a column in Microsoft Word by selecting ‘Column Width’
on the Learning Tools toolbar.

Click the ‘View’ ribbon and click on the Learning Tools icon | |¢,)
to display the Learning Tools toolbar. Learning

Tools

Sheffield.docx
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Use ‘Narrow’ or ‘Very Narrow’ to reduce the column width.




Changing the Page Background

Changing your background colour can help to reduce visual stress and can make
reading more comfortable. We will look at changing this in Microsoft Word.

In the Learning Tools menu, select ‘Page Color’ and choose from the available
options -
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Select your preferred background colour, using either a preset colour or by selecting
‘More Colors’ to pick your own.

Selecting ‘More Colors’ will display the standard
Windows colour picker.

Colors ? X
CStandard | Custom You can use the ‘Custom’ tab within this menu
Colors: Cancel to pick the exact colour you need.

Colors

Standard Custom

Colors:

Current

Color model: | RGB

Red: 255

255

255

Current




Page Background in Microsoft Edge

To change the page background colour in Microsoft Edge, you will need to be in
the Reading View (see page 6). Open the Reading View toolbar and select the
‘Learning Tools’ button.

The following menu will appear -
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Using a Line Focus in MS Word

This feature allows you to reduce the amount of visible text on the screen as you

read. You can choose to view either one, two or five lines of text at a time.

Open the Learning Tools toolbar (see page 3) and select the ‘Line Focus’ button.
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You have the option of focusing
on one, three, or five lines at a
time. Select the desired setting
from the menu.

The screenshot below shows the Line Focus tool being used with one line of focus -
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Using a Line Focus in MS Edge

To use the Line Focus in Microsoft Edge, bring up the Reading View toolbar and
select Learning Tools (see page 6 for instructions).
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Line focus
Select ‘Line Focus’ to be ‘On’, Helps to focus while reading by highlighting sets of one, three

or five lines
and choose one, three, or five
lines of focus using the buttons @ o
at the bottom of the menu. =

Here is the menu with the line focus switched on, and five
lines of focus selected -

The text is now displayed with five lines of focus -
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Sheffield, town, city, and metropolitan borough, metropolitan county
of South Yorkshire, north-central England. Sheffield lies about 160
miles (260 km) northwest of London. The city and metropolitan
borough lie within the historic county of Yorkshire, except for the

area around Beighton and Mosborough, which belongs to the historic

To scroll through the text, click the up and down arrow buttons
in the bottom-right hand corner, as highlighted above, or use
the up and down arrow keys on your keyboard.




Text Spacing

This feature will increase the spacing between letters on the page.

For Microsoft Word, open the ‘Learning Tools’ toolbar and select the
‘Text Spacing’ button.

Spacing

The horizontal and vertical text spacing will now be increased -
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When using Microsoft Edge, select the ‘Learning Tools’ tab from the Reading View
toolbar and select ‘Text options’ - Switch “Text spacing’ to ‘On’ -
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The vertical and horizontal text spacing is now increased -
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Spellchecking

Microsoft Word has a great spellchecker built-in, which most of us already use. We
can load it by selecting ‘Check Document’ in the Review tab, or by pressing the F7
key.
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However, sometimes it can be hard to choose the right suggestion. For example,
‘psyhics’ gives us these suggestions:

Suggestions

psychics

We Wanted to Write ‘phySiCS’ clairvoyants, spiritualists, soothsayers
here but if we just look at the physics

spellings, it can be difficult to astronomy, behaviour

work out which one to use. psychic’s

clairvoyant's, spiritualist's, soothsayer's

Ignore Once

Ignore All

Word now helpfully includes ‘synonyms’ alongside its spelling suggestions. A
synonym is a word that is very similar to another word. These are highlighted below
in the case of physics.

astronomy, behaviour

If this does not help you identify the correct spelling,
additional options can be used, which are described on
the next page.




Spellchecking cont.

If the synonym alone hasn’t helped you correct the spelling, you can select the down
arrow next to the spelling suggestion.

In the menu, clicking ‘Read Aloud’
psychics will read out the word for you, along

clairvoyants, spiritualists, soothsayers

with any synonyms associated with
"'t‘“'“ . it. This is very helpful when the
astronomy, benaviour

suggestions are spelled similarly but

sychic's Read Aloud .
pey ead ou sound different.

clairvoyant's, spiritualist's, soot

Spell Out

| 0]
Ignore Once Change All Clicking ‘Spell Out’ will spell out the

Ignore All Add to AutoCorrect ;
4 o rroome suggestion for you.

You can also read out the sentence in which the spelling mistake is made, by clicking
on the audio button next to the sentence -

Spelling
Not in Dictionary

When | go to university | want to study psyhiss.

and become an engineer. <)

Suggestions
physics
astronomy, behaviour

psychics

clairvoyants, spiritualists, soothsayers

psychic’s

clairvoyant's, spiritualist’s, soothsayer’s

Ignore Once

Ignore All









